PeopleSoft XML Publisher

Primer

This document is a Primer on using XML Publisher for PeopleSoft. It is written by David
Vandiver.
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Install

Welcome to our first session on XML Publisher for PeopleSoft. In this session, we will discuss
how to install the plugin, verify the install, and create the xdo configuration file. This training
series will focus on the development aspect and assumes that XML Publisher is already
configured on the application server by the system administrator.

Download Word Plugin

The first thing we need to do is download the Word plugin, which is stored within the PeopleSoft
application. You can go to any of your PeopleSoft environments, including Demo.

Once in PeopleSoft, navigate to
e Reporting Tools

XML Publisher

Setup

Design Helper

Query Manager | - |

RACLE’
rites Main Menw ﬁggg_r_ti@_]:gqlgj > Query > Query Manager
A r
M 1 Cuery *
'y Manager [ Connected Query r

AR

“any information you ha 3 PS/niision

an Existing Query | C 3 ®ML Publisher

~ |5 Reporting Cansole 5 Setup S Report Gt
Data Source eport Lategary
. Report Manager .
arch By: |Quew Nar || 3 Repart Defintion 5 Global Fraperties

5 |Advanced Search .
zarch ] Content Library =] Design Helper

This will open a page with a single link. Click the url link to download the Plug-In for Microsoft
Word. In this session, we are using Firefox, so the download might look differently from other
browsers. We will save the file to the default location Downloads. Once the download is
complete, we will open the folder to find the zip file. We now must unzip the file. We will extract
the zip file contents in the same folder.

Once the file is unzipped, open the XMLP_DESKTOP folder and locate the Bl Publisher
Desktop file. Open this file to begin the Word Plug In installation.

We will accept the defaults during the installation process. This install not only gives us the
Word Plug In, but also installs a Start Menu folder with demos, samples, PDF User Guide, and
other development tools.

When the install is done, click Finish.
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Verify Install
There are two methods to check the installation.

The first method is to review the Start Menu folder called Oracle Bl Publisher Desktop. In this
folder, there should be a Demos and Samples folder, as well as a User Guide and other
development tools. The user Guide will come in handy as you advance in your development
skills of Bl Publisher.

W acuaror FlashFiP
L‘ﬂ-l Microsoft Sikverlight » @ Flas
iﬁ Micrasoft OFfice Publ MixMeisker » Demos »
I_,'—:: 2007
Mozilla Firefox Samples 3

I?r BI Publisher Users Guide

Mice PDF Compressor 4 Template Builder for Ward Language

oDesk 3
office Convert Pdf to Jpg Jpeqg Tiff Free

Iﬂ_ﬂ Template Builder for \Word Tukarial

EE Template Viewer

Cracle BI Publisher Desktop Template Wigwer Help

The second method is to open Microsoft Word and review the Add In.

If you have Word 2007 or 2010, your experience should look similar to what appears in this
training video. You should have an Add Ins menu option on the far right. Once you go to this
menu, you should see the Oracle Bl Publisher Ribbon.

41

'fﬁ;‘l, = QS v Q.rs@a Sample 1.rtf - Microsoft Word
il

Home Insert Page Layout References Mailings Review View Add-Ins

Oracle BI Publisher = ||| Data ~ Insert ~ Preview ~ Tools = Help

EBluetooth =
Menu Commands Custom Toolbars
[ Oracle BI Publisher [ » » 1 » 1+ v @ a0 0 e 3 o ]

There are two ways to navigate to most of the actions. You can click the Oracle Bl Publisher
menu options. You will notice that the items under Insert are the same as the Insert menu, but
sometimes in a different order.

One note to point out. For Peoplesoft installations using Oracle Bl Publisher, the Log On menu
option is not used.
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As your preview the menu options, you will see there are actions to load the XML Data and
Schema files, insert fields and conditional formatting, preview in an assortment of formats, and
additional developer tools to assist in creating XML Publisher reports.

XDO Config File

One final item you may need to configure on the desktop installation is the xdo file. Both the
desktop and server can and should have an xdo configuration file. The desktop xdo file is only
needed for development, and can be configured as needed. By default, an xdo.cfg file is not
installed on the desktop.

If you plan to develop reports needing MICR or Bar code fonts, you will need to configure the
desktop xdo file. Navigate to the Program Files directory, and locate Oracle, Bl Publisher, Bl
Publisher Desktop, Template Builder for Word, Config. You can copy the xdo.sample.cfg file
and name the new file xdo.cfg. If you cannot see your file extensions, then just name the file
xdo and ensure the Type remains as a CFG File.

= :Y\Program Files\Oracled\BI Publisher\BI Publisher Deskiop! Template Builder For WordyconFig
x Mame Size  Type
ZKE CFGFile

1 [5) Mawie Maker A xdo example.cfg

o

Open the xdo file in an editor and review the fonts section on examples. We will cover fonts,
such as MICR and Bar Codes, in a later session.

Page 4 of 19



xdo example.cfg =

T T T T L A . L - - L T
1 <zonfig wersion="1.0.0" xmlns="http:/ xmlns.oracle.com/oxp/contiogl ™=
z <!-— Properties -->
2 <properties>
4 <!—— Byatem lewvel properties -->
=
[ <!=-= PLEALZE 3ELECT & VALID TEMPFILE DIRECTORY!!! ——=>
7 <property name="system-temp-dirTro: S Tewp</ propertys
=
a “<!=— PDF compression -->
10 <property name="pdf-compression"rtrue</propertys
11
1z “<!=—= PDF security -->
1z <property name="pdf-security"rfalse</propertys
14 <property name="pdf-open-password”ruser</propertyr
15 <property name="pdf-permissions-passwordroWner</propertyr
1& <property name="pdf-no-printing"rtrue</propertys
17 <property name="pdf-no-changing-the—-document ">true</ propertys
1z </propertiesx
1a
za
Z1 <!—— Font setting -->
i <«fontsx
3
z4 <!—— Windows Wingdings font -->
Z& <font fawmilv="Wingdings" style="normal™ welght="normal™>
G <truetype path="Ci\WINNT, fontahwingding.ttf™ />
z7 </fontx>
a8
za <font family="GnuMICR" style="normal"™ weight="normal™>

As a final reminder, this xdo file only applies for local development on this desktop. The
server’s xdo file will also need to be modified if adding new fonts to a report.

You now have the Oracle Bl Publisher installed on your machine. In our next session, we will
create a query and start development in Word.
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Create the Template

Create a basic Query

We are going to create a basic query that joins the VOUCHER and DISTRIB_LINE tables.

Query Hame: xmL_TRAINING_WCHR

Click falder next to record to show fields. Check fields to ad
additional records by clicking the records tab. When finishe

Chosen Records

Alias Record
A WOUCHER - AP Youcher Header Tahle

B DISTRIB_LIME - Woucher Distribution Tahle

We’'ll show some basic fields, like Voucher ID, Invoice Date, Account, Department, etc.

Cuztomize | Find | “iews .
Col Record.Fieldname Format ©Ord XLAT Agg Heading Text
1 ABUSIMESS_LIMIT - Business Linit Chard LInit
2 ANOUCHER_ID - Woucher D Chard Youcher
3 AIMNVOICE_ID - Invaice Mumber Char3n [rvoice
4 AIMNVOICE_DT - Ihvoice Date Diate [Crate
5 ANVERDOR_SETID - Yendar SetlD Chars Wndr SetlD
B AVERDOR_ID - Yendor 1D Charli YWendor
T BMOUCHER_LIME_MUM - Woucher Line Mumber  [Mumb.0 Line
2 B.OISTRIB_LIME_MUM - Distribution Line Muma.0 Distribution Li
9 B.DESCR - Description Char30 Descr
10 BACCOURNT - Account Char1 Account
11 B.DEFPTID - Department Char10 Crept
12 B.MORETARY _AMOUMNT - Monetan: Amount ShmZa.3 Armoumnt
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We will make the query be Public.
Gluery Properties

*Query: (KML_TRAINING _WCHR

Description: |

Folder: |

*Query Type: | Iser vI
*OWner: I Fuhlic TI

I Distinct I Security Join Optimizer

Query Definition:

We will make the criteria be based on two prompts (Business Unit and Voucher ID)

s
Customize | Find | Bl | #:= First

Logical Expressioni Condition Type Expres=sion 2

[ =] ABUSINESS_UNIT- Business Unit  equalto B.BUSINESS_UNIT - Business Unit
ARD | ANOUCHER_ID - Voucher D equal to BAYWOLUCHER_ID - Youcher ID

ARD *| ABUSIMESS_UIMIT - Business Linit egual to N

ARD | ANOUCHER_ID - Voucher D equal to 2

Lastly, we will run the query to ensure the query functions. It is best to have as many of the
fields in the query, before working on the Word RTF Template. Add any fields that you might
remotely need, as adding them to the query later adds extra effort.

Capture the XML Output

To run this next piece, we need to save the query and go back to the Query Manager window.

Search for your query again, and choose XML.

RBunto Runto Runto

Select Query Hame Descr Lwner Folder Edit schedule
Select Querny Hame Descr Owner Folder Edit HTML Excel XML Schedule

[T HML_TRAIMING_WCHR Fuhblic Edit HTML Excel xML Schedula
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You should receive a prompt page (if you have criteria prompts). Enter sample values and then
press enter. Depending on your browser, save the file. You may want to save the file with a
portion of your sample data. These XML files will be referred to as XML Data files.

AML_TRAINING_VYCHR

Unit: LIs00q
Youcher: [0oooons

Yiew Results

| | unit | Voucher | Inwoice | Date | WndrSetiD | Vendor | Line |  Distributic

Opening XML_TRAINING_¥CHR.xmil

‘fou have chosen ko open

|| ¥ML_TRAINING_¥CHR.xml

which is &t ¥ML Document
Fram: http:/{demol. erpassaciates.cam: 10040

—wWhat should Firefox da with Ehis File?

" openwith | #ML Editar {default) |

i Save File

[T Do this automatically Far files like this from now on,

Ik I Cancel

If you have to add more fields to your query after building the Word RTF template, you should
probably recreate the XML Data files.

Enter name of file to save to...
Save i I - Downloads j %) |

1 archive

|1 xmlp_desktop

[=}00000051 _#ML_TRAIMING YCHR, <l
|2 00000032 _=ML_TRAINIMG _WCHR., =l
|| LRGYCHR._#ML_TRAIMIMG _YCHR.=ml
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Building Our First RTF
Open Microsoft Word, and go to the Add In tab. Click Data and choose Load XML Data.

Tn | 9 ¥ =g ) 7 sample 1.rtf - Microsoft Word
2 =
—-’/ Home Insert Page Layout References Mailings Review View Add-Ins

Oracle BI Publisher = | |Data =|Insert *~ Preview = Tools = Help ~

Bluetooth ~ [ Load XML Data...
= Load ¥ML Schema...

There is an option to load the Data and Schema separately, but with the XML file that was

created with the Query tool, it has both the schema and data. So we can just load using the
“Load XML Data”.

Note: If you come back to the RTF file later, you need to reload the XML Data each time.

You add fields by choosing Insert > Field. You can drag and drop the fields

@NUMFaWs
DauUet ynarnne
@xmlns: s

m]
]
]
BUSI NESS_UNlT O @xsi:noMamespaceSchemal ocation
=

@rownurmber

VOUCHER_ID

Woucher Id
Irvnice Id

Tremica Mk

0oooao
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Reviewing the Output in PDF
Choose Preview - PDF. This should open the report in your Adobe Reader.

Preview =|Tools = Helg

FDF
£] HIML
—

B[ EXCEL
[ EXCEL2000

iw RTF

[nF PowerPoint

There is a Preview - RTF, but most of your reports will probably be PDF output. Though a bit
confusing, you will build the template in RTF, but have the output be in PDF.
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Connecting PeopleSoft to the Template

Creating an XML Data Source
Navigate to Reporting Tools = XML Publisher > Data Source - Add

Reporting Tools > XML Publisher > Data Source

[ Query 3
1 Connected Query r

1 [ PSinyision ko
1 ML Publisher

. |5] Reporting Console J Setup

* [ Repart Manager |j Data Source

Pick PS Query for your Data Source Type, then pick your query name for the Data Source ID.

Data Source

Find an Existing Yalue | Add a Mew Value

Data Source Type: | PS Query |

*Data Source ID: AML_TRAINING_YCHR @, I private Data Source
Add

Find an Existing Yalue | Adda Mew Yalue
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After you click ADD, Enter a description and the Object Owner ID, then click both GENERATE
links for the Sample Data File and Schema File. Then press SAVE.

Data Source

Data Source Type: FS Guery

Data Source ID: AML_TRAIMIMG _WCHR

Description: |}{w||_ Training Youcher ¥ pctive
Object Owner ID: | Payahles =]

Registered Date/Time: OBINGEM 2 12:27.07AM  Registered Byw: W

Last Update Date/Time: Updated By:

Related Files

File Type File Generate File Or Upload File
Sample Data File Hhl TRAIMING WCHR ML Fegenerate ar  Upload
Schema File HhlL TRAIMIMG WEHRE XSD Renenerate

Creating the Report
Navigate to Reporting Tools - XML Publisher = Report Definition - Add

1 Setup
|=| Data Source

we and elick Search | ﬁ Report Definition

Enter a Report Name. Use the Data Source Type PS Query, and enter the Query name. Then
select ADD.

Report Definition

Find an Existing Yalue | Add & Mew Value

Report Hame: |}{h'1 L_WCHR

*Data Source Type: | PS Query |

Data Source ID: |}{|‘I.I'|L_TR.5.|N|NG_"\-"CHR QQJ
pdd
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On the first page of the Report Definition, enter the following:
e Report Description
e Change the Status to Active
e Pick a Report Category. ALLUSER most likely is the best default if you do not utilize
Category ID Security.
e Leave the Template Type as RTF

iy Template | Output | Properies || Security | Bursting

Report Hame: BML_WCHR

Data Source Type: FS Query
Data Source ID: HhL_TRAIMING _WCHR

Data Source Description: XML Training Voucher

Report Properties

Report Description: |KML Yaucher

*Report Status: [ Active =]

*Report Category ID: |*E%|—|—U5EH @, Al PeopleSoft User
Object Owner ID: | PeopleTools |

*Template Type: Iﬁ

Retention Days: l_

Registered DateTime: Registered By
Updated DateTime: Updated By:
Download: Data Schemna Sample Data
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On the second page of the Report Definition, take note of the Template ID. You can change it if
you desire.

For the Status, change it to be Active, then upload the RTF file. Then select SAVE.

Mzgutput A Properties uEnalc:urit\f 3 Bursting N

Report Hame: AML_WCHR
Template Eind | “iewe &l First
Template ID: HML_WCHR_1 ¥ Default Template
Description: |
*Language Code: | Enalish j Channel: | j
Template Files Eind | “iewe &I First 4
Effective Date: OB/OE2012
*Status: I Artive vI
Template File: Sample_1.1f i Upload | Preview | [ yse af
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Building a Page
For our test, we are going to modify the AP Voucher Entry page in Financials. You can also
build your own page and use the same coding method we will demonstrate below.

We are going to modify the button found on the subpage VCHR_HDR_SBP. The field is
VCHR_PANELS WRK.AP_INV_PRINT_PB, but the code is on the Component
VCHR_EXPRESS.

:avovrites Main&ﬂenu i Accountg Payable Voughers i Add,‘uvpdate »  Regular Entry

] Related Inforration & Mew Window  (2)Help [ Custor
1 1=

Summary | Related Docurnents | N Payments || Youcher Aftributes || Error Summaty
Business Unit: =001 Invoice Mo: 10M Action: I =
Voucher ID: 000000g1 Invoice Date: 081252003 -
Voucher Style: Regularvoucher Accounting Date: 091272003 I Tax Exempt

Open the component VCHR_EXPRESS, and click the STRUCTURE tab to load the
peoplecode. Right click and choose “View PeopleCode”. Find the record
VCHR_PANELS_WRK and the field AP_INV_PRINT_PB.

[YCHR_EXPRESS.GEL.YCHR_PANELS_WRICAP_INY_PRINT_PB.FieldChange

Tools Go  ‘Window Help

10 A 5 e s e |

AP_INV_PRINT_PB [field] j |

PO_PCT_ALLOCATE [field] =
DIST_PCT_ALLOCATE  [field)

YaT DIST PB [field]

KK_CLOSE_FLAG [field]

ASSET_ID [field) L
SEQMEBR [field]

GOTO_DISTRIE [field)

WCHR_PAMELS 'WRE [record]

AP THY PRINT PR iheldi

CANCEL PR Thieid]

DESCR_PB [field]

OK_PB [field)

YCHR_COMMENTS [field)

wWTHN APPlI FILR [haldl

We will comment out the delivered code, which uses an App Package and Rowset processing.

I.-"*impu:urt AP:VWoucher: InvoicePrint;
Local 4P:Voucher:InwvoicePrint solnwPrint = create AP:Voucher:InwoicePrint("VOUCHER™) ;

solnwPrint. PrintInvoice()
w
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Below is the new code you can use. This code is also in an attached TXT file on the CD.

/*Taken from http://www.pscustomizer.com/peoplesoft-examples/xmlp/xmlp-in-pc/*/
/% LU i %y

/* You must reference an application package at the beginning of the event */
JF LU L L i k)

import PSXP_RPTDEFNMANAGER:*;

Local Record &rcdQryPrompts;
Local string &LanguageCd, &MyTemplate, &MyReportName, &OutFormat, &BusinessUnit, &VoucherID;
Local date &AsOfDate;

/* | T I A A A */

/* Set XML Publisher report required parameters */
/% LU i k)

&LanguageCd = "ENG";
&AsOfDate = %Date;
&OutFormat = "PDF";

/o T T A A O o O B O O A e N N

/* Create a PDF using XML Report Definition MY_ XMLP_DEMO */
/* T A O A A */

&MyReportName = "XML VCHR";
&MyTemplate = "XML VCHR 1";

y A N B NN

/* Get the values from the page */
/*IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIlllllllllllll*/

&BusinessUnit = VOUCHER.BUSINESS UNIT;
&VoucherID = VOUCHER.VOUCHER ID;

/2 T T B O B O O O R N

/* Declare and Instantiate (construct) your Report Definition Object */
% LLLLLL i i i i i i i i i i k)

Local PSXP RPTDEFNMANAGER:ReportDefn &oReportDefn = create
PSXP RPTDEFNMANAGER:ReportDefn (&MyReportName) ;

/* | T I O A A */

/* Get a handle on your Report Definition */
JF UL U i %

&oReportDefn.Get () ;

/* | 1 A O O A O */

/* Since there is a prompt to the query used in this report, you need to */

/* provide the value for the prompt */
JF UL LU T T i %y

&rcdQryPrompts = &oReportDefn.GetPSQueryPromptRecord() ;
If Not &rcdQryPrompts = Null Then
&oReportDefn.SetPSQueryPromptRecord (&rcdQryPrompts) ;
/* rrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrrnd */

/* Provide a value to the State Prompt */
Y O T O I O I O O B O O N
&rcdQryPrompts.BUSINESS UNIT.Value = &BusinessUnit;
&rcdQryPrompts.VOUCHER ID.Value = &VoucherID;

End-If;

F Al S I N
/* Kick of the report process */
% TLLLLL I iy ok

&oReportDefn.ProcessReport (&MyTemplate, &LanguageCd, &AsOfDate, &OutFormat);
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/*lllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllll*/

/* CommitWork must be called prior to displaying the output since the */
/* application package performed work and SQL statements. If you do */
/* not commit the work performed to this point you will receive an */
/* error like “Think-time PeopleCode event (ViewAttachment), but a SQL */
/* update has occurred in the commit interval. (2, 148)” */
VA R O i B R o O O R O O e O RN
CommitWork() ;

F A N O I O I o O O O O O T
/* Display Report to the user */
VA B O O R O O A O O R R NN

&oReportDefn.DisplayOutput () ;

Now you are ready to test the report. Navigate to the Voucher and open a voucher id. Then
navigate to the Invoice Information tab and click “Print Invoice”.

:a\m_rites Main&ﬂenu » Accuuntg Payable = VDuEhers » Addelpdate » Regular Enfry

[C] Related information G0 Mew window  (2)Help & Cust
Summary || Related Documents W Payments || Youcher Aftributes | Errar Summary

Business Unit: Jsont Invoice No: 1001 Action: I i
Voucher ID: ooooongt Invoice Date: 095122003 _
Youcher Style: RegularYoucher Accounting Date: 0901252003 ™ Tax Exempt -

Migration Concerns
When migrating, you will need the following items in your project:
e XMLP Data Source Defn
e XMLP File Defn
e XMLP Report Defn
e XMLP Template Defn
e Query
e PeopleCode on Pushbutton
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The tricky part is finding the XMLP File Defn. The File you attach to the Report Definition has
an algorithmic type filename.

Insert into Project

Defirition Typs:  [#MLP File Defr =] | st
Selection Criteria Clo:
M arne: ||

Mew 5
Selec

Defintionz matching zelection criterna:

File Hame | File Hame

L4 7UH 3R G 320w QLLF 29 PO _=MLP_COMFIGDTLS otf
1DBEYFRIRGDEZGOSTALYO Ex_EVLT _=RPT.rtf
10KEVBSZHGILTYOPHEEG RA_FedMonFed_SubawardBudget_new1.2.
20048097 Z<GE Q4D AW IR KW GL=E1 100t

20GE0AGMYIHGCEDEGIDA5-0 BI_#PSF103=_EMG_SUMMARY 1tf
2HOwAAPIHGMHBER Q7K HYG FS=001 2. rtf

One trick is to use the “Related Items” when adding the Report Definition in App Designer.

Insert into Project

Definition Type: |><I‘v1 LP Repart Defr ﬂ Ihgert
Selection Criteria Belated Definitions Close
M ame: |><ML #MLP Filz Defn

#=MLP Template Defn

dd

Mew Search

Definitionz matching zelection critera;

Report Defn |d
=ML WCHR

You can also query the PSFILEDEFN table where USERFILENAME LIKE ‘XYZ%’
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Advanced Template Building

To take XML Publisher to the next level, this section will discuss advanced features in building
your template. In addition, having expert Word training will also assist in producing a quality
product.

Tables

Use the menu Insert - Table Wizard. Once you are done, look for the special characters that
mark the start and finish of the WHILE loop.

IF Conditioning

These come in handy, especially when you want the label for a field to be hidden when there is
no data present.

Headings and Footers

You cannot drag and drop the fieldnames on Word’s Header or Footer sections. But you can
manually write the fieldname using the XMLP codes. For a field called BUSINESS_UNIT, use
<?BUSINESS_UNIT?>. The fieldnames have given me trouble when | do not match the case;
one easy solution is to drag the field to the body of the report, then click on the field and find the
code under the Advanced tab.

-

Properties Advanced

Code
BUSlNESS_UN|T <PBUSIMESS_UMIT ¥>

Bar Codes

You need to load the font on both the local desktop and server. Next, you pick the field and
change the font to be the Bar Code font. The final piece is you need to reference the bar code
in both the local and server xdo.config file.

Disclaimer

Oracle and PeopleSoft are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of
their respective owners, such as Microsoft.. David Vandiver does not represent Oracle, PeopleSoft, or Microsoft.
The user reading this document takes full ownership of any consequences, be they ill or for good, and may not hold
David Vandiver liable for the contents of this document, especially in the event of your database becoming corrupt or
worse, truncated. If there are any further questions, the answer is 42.
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